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SUMMARY

The planned retirement of the Elxsi 6400 mainframe computer at ARL has
necessitated the conversion of the general purpose Fortran data plotting program TRANS to
operation on a Macintosh llfx personal computer, where it has been renamed MacTRANS.
The conversion has included the limited use of regular Macintosh features such as pull down
menus, and allowed the plots produced by MacTRANS to be edited in most commercial
Macintosh graphics programs. For most cases, the execution speed of MacTRANS on the
Macintosh llf-x has been found to be faster than that of TRANS on the Elxi.
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1. INTRODUCTION

The imminent retirement of the Elxsi 6400 mainframe computer at ARL has necessitated
the transferral of several programs to other computers. While many of these programs
perform large amounts of numerical calculations, and thus are more suited to transferral to
other mainframe computers, the programs which are graphics intensive are more suited to
transferral to computers which specialise in the presentation and manipulation of graphics.

The Macintosh Tfx was selected as a possible alternative for these graphics intensive
programs as, in addition to the graphical capabilities it shares with the other Macintosh
personal computers, it possesses the fast processing speeds necessary for it to be a viable
alternative to the Elxsi. However, the Macintosh computers use a completely different
graphics system to the Elxsi, and thus these programs need to be significantly modified.

This document presents the conversion of the general purpose data plotting program
TRANS (Refs 1-3), which uses the DI-3000 computer graphics packagel, from operation
on the Elxsi to operation on a Macintosh llfx, where it has been renamed MacTRANS.
MacTRANS will also run, albeit with some speed penalty, on other Macintosh computers
equipped with 68020 or 68030 processors, plus 68881 or 68882 maths coprocessors.

The conversion has involved the modification of the Elxsi Fortran code so that it would
compile under Language Systems Fortran (Ref. 4) in the Macintosh Programmers
Workshop (MPW) environment, the development of a partial emulation of the DI-3000
graphics package using Macintosh QuickDraw procedures, and the addition of an "event-
loop" 2 to the program so that some of the regular features of the Macintosh could be used,
e.g. pull-down menus and "clicking" between windows. However, the basic structure of
the program has been left intact.

2. CONVERSION STRATEGY

The strategy adopted in the conversion of TRANS to MacTRANS was to

a) make the necessary changes to the Fortran code to remove all the Language System
Fortran compile-time and run-time errors

b) fix any errors in the parts of the program that produce non-graphical output, and tailor
this output so that it can be printed with the minimum of alteration on an Apple
LaserWriter through MPW

c) develop the DI-3000 emulation to the extent of producing an image on the Macintosh
monitor, and fix any errors in the graphics producing sections of the program

d) add colour to the graphics

e) produce the code necessary to save the graphics in PICT files 3

D13000 is a computer graphics package from Precision Visuals Inc., Colorado USA that plots graphics
in two or three dimensions. It is used in combination with the Metafile System from the same
company, and stores the D13000 graphical information in a device independent file called a metafile,
which can then be read by a metafile translator and plotted on various devices.

2 An event-loop is the fundamental part of a Macintosh application which examines the events that occur
while a program is executing, e.g. mouse button 'clicks' and menu item selection, and passes control
to the relevant sections of code to provide the appropriate actions.

3 A PICT file (defined in Macintosh Technical Note #27) is a data fork file with a 512-byte header,
followed by a QuickDraw data structure within which drawing opcodes represent a graphic image.
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f) add the event-loop

g) incorporate graphics printing into the event-loop

The code modifications and additions are dealt with in Sections 3 to 9, which give
representative examples for each change made. A more comprehensive description of the
modifications is given in Ref. 5. Wherever Macintosh Toolbox (intrinsic functions and
procedures) or QuickDraw (subset of the Toolbox dealing with graphics procedures) calls
are shown in the text, the reader is referred to Ref. 6 for information on the variables
shown in the calls and the exact actions carried out by them. These calls also need
compiler switches, include files, and special calling procedures which are dealt with in
Appendix A (see also Ref. 4). Similarly, wherever DI-3000 calls are shown, the reader is
referred to Ref. 7. TRANS commands are summarised in Appendix B.

3. NECESSARY CHANGES TO ELXSI FORTRAN

These are the changes that were needed to remove the compile-time and run-time errors,
and to accommodate the differences between Language Systems Fortran and Elxsi Fortran.

3. 1 Intrinsic Functions

The bell sounding and file renaming subroutines were rewritten to use the Macintosh
Toolbox equivalents of the Elxsi intrinsic calls, as shown below.

a) Bell
Call SysBeep(Duration) !Duration in 1/60 th's of a second

b) Rename
OSErr = GetVol (Int4 (0), %Pef (VefNum)) !Get Volume Number
OSErr - Penave (OldFileName, VRefNm2, NewFileNae) !Change File Name
OSErr = FlushVol(Int4(0),VRefNum) !Update Volume

3.2 Encode Statements

Problems were experienced with the ENCODE statements which stored character data in
real variables, particularly where these variables were subsequently used as formats. In
these cases the original ENCODE statements were changed to internal WRITE statements, and
the real variables were changed to character variables. For example, in Subroutine
PNTHDS, the code

102 FUM(3H ',,I1)

30 NCXOE(4,102,TTY(4))NC

was changed to
30 WRITE(TTY(16:I6),' (II) ') NC

where "TTY" was changed from a real*4 array "TTY (8)" initialised by
DATA (TTY(J),J=l,8)/4H(2X,,4H' T,4Himre ,4H ',5,

1 4H(- ,4HBk#,4H',i4,4H)) /

to a character*31 initialised by:

DATATTY/'(3X," Time 1,5('' Blk#'',14)/)'/

It would appear that the ENCODE statement cannot be used to encode characters (or
character variables) into real variables; it can only be used to encode characters into other
character variables. However, it is possible to use an internal READ statement to read
characters into real variables.

2
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3.3 Formats

It was necessary to insert the additional edit descriptor "ix," to the start of all the write
statement formats to perform the function of a carriage control character, to ensure that the
first character in each write was printed.

3.4 Mismatched Variable Types

The Elxsi version of TRANS extensively used real variables to store character data.
This was acceptable in Language Systems Fortran where data was read into real variables
(with the exceptions noted in Section 3.2), but resulted in problems when these character-
containing real variables were compared to other character or string variables. This mostly
occurred when a response from a keyboard entry was compared to a character constant.

The problem was removed by assigning the character constants to real variables in data
statements and then using the real variables in the comparison expressions. For example,
in Subroutine TRAN2, the code

TYPE 305
305 FONAT (IX, 'ARE SYNWIS RERlD FOR PITS

ACET 201, SYt-MS
201 FaW T(A3)

CALL CHKUPR (SYIA,I) !COVERTS TO UPPER CASE
IF (SYMAS. ZQ. 'Y') GO TO 325

in which Symms has a default type of REAL*4, was changed to

TYPE 305
305 FOa (IX, 'ARE SYMBOIS REQRD FOR PIOTS :)

ACCEPT 201,SWM
201 FXXR (A3)

CALL CHIPR(SYMNS, ) !CWNVERTS TO UPPER CASE
IF(SYMANS.ZQ.YES$) GO TO 325

where YES$ (a REAL*4) was assigned in the data statement:

DATA YES$1'Y'I

Note: A similar problem occurred when characters were stored in integer variables as
well. However, in this case, the character-containing integer variables could be
directly compared with character constants (as in i. r. ,,), but not with character-
containing real variables (as in snwms. E. i).

3.5 Opening and Closing Files

In Elxsi Fortran code, the OPEN statement can be used a second time (i.e. after the file
has already been opened) to reset the file pointer to the beginning of the file. In Language
Systems Fortran, however, once a file is opened it must be explicitly closed before it can be
opened again (otherwise a run-time error will result). This necessitated the inclusion of
two crmo statements, one at the end of Subroutine BLKLST (CIosE (20)), and the other
before the call to Subroutine TRAN2 in the main program (cao (1)).

3.6 Save Statement

Elxsi Fortran automatically saves all subprogram (subroutine or function) variables
between calls to those subprograms, while Language Systems Fortran does not.

To overcome this problem, the "-saveall" compiler switch can be used at the
compilation stage, which may significantly slow execution of the program, or the necessary
variables can be saved individually in the appropriate subroutines and functions with the

3
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SAVE statement, as was done in MacTRANS. The subroutines and variables involved are
shown in Table 1.

TABLE 1
Subprogram Variables Put into savz Statements

Subprogram Variables

BLKLST N

BRKLIN All variables

INBLK IDATA, LNUMS, SAVE

STRIP Y, P, UP, ND, XLA, YLA, NOPIPS

TRAN2 NOPEN, Y, RECTS, PICTURES,
SCALING, JUST, NAME, OFFSET,
WINS, MARK

4. ADDITIONAL CHANGES TO FORTRAN CODING

Additional changes were made to tailor TRANS to the Macintosh. These included:

Main Program - Removal of the default plot offset (used for a particular plotting
device linked to the Elxsi).

Subroutines FCLOSE, FOPEN, RPT, and METRED - Changes to the code
necessary for the new file-naming procedure (see Section 5.1).
Subroutine FRMOPN - Adjustment of the starting position of the plots to suit the
LaserWriter.

3ubroutines LPLOT, HEADNS, CONBLK, PNTHDS, and ZERO - Modifications
to the format statements to fit the text to the window used by MacTRANS, and keep
printer output within A4 paper dimensions.
Subroutine MOVE - Name change to MMOVE to remove a conflict with a reserved
QuickDraw procedure name.

Subroutines NUMB, PLTHD, XAXIS, and YAXIS - Adjustments to the positioning
of the text in the plots to suit the Times font used in MacTRANS.

5. DI-3000 GRAPHICS EMULATION

The partial implementation of the DI-3000 graphics routines using QuickDraw
procedures involved emulating some of the DI-3000 routines and leaving the rest as
dummy subroutines, as illustrated in Table 2.

4



TABLE 2
Skeleton DI-3000 Program Commands and Emulation Actions

Command DI-3000 Action QuickDraw Emulation

CALL JBEGIN Initialise DI-3000 No action

CALL JDINiT (1) Initialise device number 1 No action

CALL JDEVON (1) Activate device number 1 No action

CALL JVSPAC (...) Set the dimensions of the No action
display device

CALL JVPORT (...) Set the viewport on the No action
display device

CALL JWINDO (...) Set the window bordering Set the size of the picture
the objects to be viewed frame (@ 300 dpi) and

window (to fit the screen),
and set the scale factor

CALL JFRAME Cause a new frame action Open a new window of the
size calculated in JWINDO

CALL jOPEN Open a segment Open a picture with the
picture frame set in
JWINDO

CALL JMOVE (...) Move the pen to the global Same ss DI-3000
coordinate in the argument

CALL JDRAW (...) Draw to the global Same as DI-3000
coordinate in the argument

CALL JCLOSE Close the segment Close the picture and save it
in a PICT file

CALL JPAUSE (1) Wait for user response Walt for mouse button click

CALL JDEVOF (1) Turn off device number I No action

CALL JDEND (1) Terminate device number 1 No action

CALL JEND Terminate DI-3000 No action

Note: A DI-3000 program need not call JFRAME at the start of the first picture; however,
in this emulation it is necessary.

5.1 Metafiles and PICT Files

The DI-3000 graphics package allows several individual frames (pictures) to be saved
in one metafile. In the MacTRANS emulation, the frames were replaced by QuickDraw
pictures, and the metafile by several PICT files (each containing one QuickDraw picture).
PICT files are described more fully in Section 7.

To accommodate the consequential increase in the number of picture files, the file-
naming procedure was modified. The new procedure adopted gives each PICT file

(5



produced from a single plot command (PLS or PLO) the same name it would be given in
TRANS. but with a single character extension to identify it. These characters start with a
lower case "a" and continue alphabetically. For example, a data file with the name
"POLAR.DAT" would have the first group of PICT files (from the first plot command)
named "POLAR.PLT.a", "POLAR.PLT.b", etc; the second group (from the second plot
command) named "POLAR.PLO.a", "POLAR.PLO.b", etc; the third group (from the third
plot command) named "POLAR.PLI.a", "POLAR.PLI.b", etc; and so on.

This modification was implemented in the new code associated with the DI-3000
grapi'ics package emulation, but also required changes to several sections of the existing
TRANS code. The sections of TRANS code involved were those that

• checked for existing metafiles produced from the current data rde (Subroutine FOPEN)

" renamed the metafiles from "META.TEMP" to "<DataFileName>.PLT",
"<DataFileName>.PL0", etc. (Subroutine FCLOSE)

" overlaid plots from separate metafiles into one metafile (Subroutines RPT and
METRED)

5.2 Common Blocks
Many of the subroutines in the DI-3000 emulation required the use of common blocks

to pass values between them. All of these common blocks were included in the variable
declarations of Subroutine TRAN2 (the highest level subroutine linking together the
subroutines from which the DI-3000 calls are made), and wherevcr necessary throughout
the code (namely the DI-3000 emulation subroutines themselves and any other subroutines
that needed access to the common block variables). The following blockdata section,
showing all the common blocks and their functions, was used to set the initial default
values for the common block variables.

CDB THESE DECLARATIONS RELATE TO MAC IPIMPLExiATION OF THE D13000 CALLS
BLOKDATA D13000
RECORD /PICHANDLE/PIC(20) HANDLES TO THE PICTURES
RfORD /RECT/WINDWRET, HIRESRET BOUNDING RECTS FOR WINDOWS AND PICTURES
C44 /RECTS/WINDOWRECr, HIRESRET
OMMON /PICTURES/PIC
REAL SCALE SCALE FACTOR
OMMON /SCALINI/SCALE

INTE ER JHORIZ,JVERT TEXT JUSTIFICATION INDICFS
COMMON /JUST/JHORIZ, JVERT
DATA JHORIZ/1/,JVERT/1/ SET JUSTIFICATION TO BTIUM LEFT
STRING*255 FNT DATA FILE NA

IWFrGER*2 HOFFSET, VOFFSET GRAPHICS WINDOW OFFSET
OMMON /OFFSET/HOFFSET, VOFFSET

REORD /CKINDCWPrR/NtTR(20) POINTERS TO THE GRAPHICS WINDOWS
INTEER*4 WI NL14BER OF GRAPHICS WIN OPE
COMMON /WIES/WPTR, WU
DATA WINNUW0/ SET N.MBER OF WDW OPEN TO ZERO
INTEGER*4 ?.KSYM MARK S)L INDEX
CCMMON/MARKMKSM
DATA MKSWYI/ SET MARK S'ML TO A DOT
LOGICAL RFLAG FIAG TO STOP DISPLAYING PICTURES
O.HH4N/FLAG/RFL.AG DURING REP COMMND
DATA RFA/.FALSE./ SET FLAG TO FALSE, IE SIOW PICTURES
SAVE /RECIS/, /PICTtIRES/, /SCALING/, /JUST/, /NIME/, /OFFSET/, /WINS/, /MARK/

END

6



For the REPeat command, it was necessary to save some of the common blocks
between calls to Subroutine TRAN2 (see Section 3.6). Some of the common blocks were
also used to pass information about the windows and pictures opened by the DI-3000
emulation to the event-loop section of MacTRANS (see Section 8).

5.3 Dummy DI-3000 Subroutines

The DI-3000 routines listed below were replaced by dummy subroutines which return
control straight back to calling code without performing any operations.
JBEGIN JVSPAC JDEND JMREAD
JDIN1T JVPORT JEND JMINTR
JDEVON JDEVOF JMGET

5.4 Emulated DI-3000 Subroutines

The following DI-3000 routines were emulated:
JCLOSE JFRAME JJUST JPAUSE
JCMARK JFSOPN JMARK JSIZE
JDRAW JHSTRG JMOVE JWlNDO
JFONT JHTEXT JOPEN

A brief descriptiun of the code used to perform the actions requirea by these routines
follows.
Note: Code dealing with the variable RFLAG is not strictly part of the emsation: it was

included for the convenience of dealing with the REi-eat command.

CALL JCLOSE

a) Close tie currently open picture

CALL CtOSEPICTURE

b) If not in REPeat ccmmand, draw the picture
IF (.NCT. FFLAG) CALL DRANPICURE(PIC(WINNIM),WPTR(WItI).WP^.PORTRIcr)

c) Get the name of the current window

CALL ETrITIE PtM (WnNtM), %REF rfLUM))

d) If not in REPeat command, save the picture in a PICT file (see Section 7)
IF (. NOT. RFI),) CAIL PICSAVE (PIC (W-NMI), IMUE, ERR)

CALL JCMARK (CVALUE)

Set the mark symbol index
tM<s:,, C-VA!LE

CALL JDRAW (X,Y)

Draw a line from the current pen position to (XX,YY) - calculated by multiplying X
and Y by the scaling factor (300 dots per inch), rounding to the nearest integer, and
changing the sign of YY (the QuickDraw positive Y direction is down)

XX = ININT(X * scale)
YY= -IWfNT(Y * scale)
CALL LINE-OM(XX,YY)

7



CALL MONT (CVALUE)

Change font to "Times" - ignores argument
CALL MTMNF~T (TMES)

CALL JWRAME

a) Increment the window number
WINN"M = WINNM +1

b) Set the window title to the file name with the character extension
WINTILE = Fit@ME/' '//CHAR(9&M+ M)

c) Open a new window
PTR (WINN.) .WP = NEWCINDrW (NIL, WINDREr, WINTITLE, FLS,

1 NOGR OCPPOC, INFPa", TRU, WINt)

d) Send the new window to the front
CALL SEIORT (VIPT (WIN"t1) WPE)

e) Calculate the window offset and move the window
Ii.OB - (WM - 1) *HOFFSET + WINDUARECT.LEFr
VGfLB = (WMM - 1)*VOFFSET + WIND.WRErTOP
CALL MVEWnM0C (WPTR (WN).WP, HGOB, VGL:B, FIS)

f) If not in the REPeat command, make the window visible
IF (.bNy. RFI'.A) CALL SHCWW qND ,TR (WIN"t ) W1)

CALL JFSOPN (CODE,DSPDEV,LUN,FILNAM)

Set the file name - ignores the remaining arguments
= TRIM(FINAM)

CALL JHSTRG (STRING)

a) Get the current pen location
CALL GETPEN(%REF (PT))

b) Calculate the length of the string
LETh = IN2(L STRING))
paIXL. = TEXIWIDT (%Lc (STRr.), INT2 (0), IfLUnT)

c) Get the font information and move the pen to the position needed for the text
justification

CALL GETFONTINFO (%REF (FINFO))
SELECT CASE (JHORIZ)

CASE (1) !LEFT
CASE (2) !C B TRE

CALL ME (-ININT (Pa.tD/2.0), INT2 (0))
CASE (3) RIGHT

CALL MZEVE (-PIXLEN, INT2 (0))
ED SELECT
SELECT CASE (VET)

CASE (1) !BTTOM = BASELE
CASE (2) !C~TRE = 1/2 AST

CALL MVE (INT2 (0), ININT (FTNFO).AS2ENT/2.0))
CASE (3) !TOP = ASC1iM LINE

CALL MVE (INT2 (0), FINFO.ASCET)
END SEV.T

8



d) Draw the text and return the pen to the original position
CAL L DRAWEmX' (%IOC (STRINGE), INT2 (0), ILNGH)
CALL MOVETo (PT.H,PT.V) !REVERT TO OtIGINL LOAIONt

CALL JHTEXT (NCBARS, RSTR)

a) As for JHSTRG
b) Calculate the length of the string

PIE = TEXTWIDTH (%IDC (RSTR), T2 (0), IN12 (NCHARS))

c) As for JHSTRG

d) Draw the text and return the pen to the original position
CALL DRAWr (M (RSTR), nt2 (0), nr2 (NCHARS))
CALL M7.V-O(PT.H,PT.V) !REVERT TO ORIGINAL POSITION

CALL JJUST (CHORIZ,CVERT)

a) Set the text justification indices (arguments shown in .able 3)
JHORIZ = CIORIZ
JVERTf = CVERT

TABLE 3
Justification Arguments for Subroutine JJUST

Argument 1 2 3

CHORIZ Left Centre Right

CVERT Bottom Centre Top

CALL JMAP.K (X,Y)

a) Move to (X,Y) using a DI-3000 call

CALL W VME (X, Y)

b) Set symbol size to 0.5% of the lessor of the width or height of the picture rectangle
IF ((HIRESRECT.RIGHT - HIRESkr.LEr1').GT.

1 (HIRESRPCT.BOrrCM - HIRESRECr."JP)) THEN
SYMSZ = ININT(0.005*FLaAT(HIRSRCT.BOrrC - HIRESRECT.TOP))

SE
SYMSZ = ININT (0.005*FLOAT(HIRESRECT.RIGHT - HIRESPZCT.LEFT))

ED IF
C MAKE SYMOL SIZE AN EVEN NLBER OF PIXELS

IF (MUD(SYMEZ,2) .NE. 0) SYYZ = SYMSZ + 1

c) Draw the mark
SELECT CASE (MKSYM)

CASE()
CALL GETPEN(%REF(PT))

CT.'T.W = PT.V - SYSZ/2
MECT.BO7TcI1 = PT.V + SYMSZ/2 + 1
MECT.LEFT = PT.H - SY?.SZ/2

M4ECT.RIGHT = PT.H + SYMSZ/2 + 1
CALL PAINTOVAL a4OT)

CASE(2) ! +
CALL M0VE (INT2 (0), INT2 (-SYMSZ/2))
CALL LIM (IN2 (0), SYMSZ)

9



CALL M74E (INT2 (-SYMSZ/2), IMT2 (-SYMrZ/2))
CALL LIE (SYMSZ, INM2 (0))

CASE (3) *
CALL MOVE (INT2 (0), INT2 (-SYMSZ/2))
CALL T. (INT2(0),SY1Z)
CALL MIDVE (ININT (-0.866*SYMZ/2.0), INT2 (-SYMxZ/4))
CALL LINE (ININT (0.866*SYM-Z), IN2 (-SYMSZ/2))
CALL MOVE (INT2 (0), nIT2 (SYMSZ/2))
CALL LINE (ININT (-0.866*SMZ), INT2 (-SYM'Z/2))

CASE(4) ! CIR7LE
CALL GETP4 (%REF (PT))
1ECr.TOP = PT.V - SYMSZ/2

Er "mTr14 = PT.V + SYfrZ/2 + 1
lIECT.LEFT = PT.H - S)DSZ/2
M RP.RIGtT = PT.H + M WZ/2 + 1

CALL FRMEV ) M )
CASE(5) ! x

CALL t.'VE(INT2 (-SY'SZ/2), NT2 (-YMSZ/2))
CALL LINE (SMZ, SYMZ)
CALL MOE (INT2 (0), INT2 (-SY1SZ))
CALL LINE (-SYMSZ, SYnIZ)

CASE(6) ! SQUARE

CALL GETPEN (%R EF(PT))
MRECT.TOP = PT.V - SYHSZ/2
MREC.BOTTCM = PT.V + SY)IJZ/2 + 1

ECT.LEFT = PT.H - SYMSZ/2
1RECT.RIGHT = PT.H + SYMSZ/2 + 1

CALL ? (.r-ECT)
/D SEL.ECT

d) Return the pen to its original position
CALL JMVE (X,Y) !RETURN TO START POSITICN

CALL JMOVE (X,Y)

Move the current pen position to (XX,YY) - calculated by multiplying X and Y by
the scaling factor (300 dots per inch), rounding to the nearest integer, and changing the
sign of YY (the QuickDraw positive Y direction is down)

XX = ININT(X * scale)
YY = -ININT(Y * scale)
CALL VE0 (XX, YY)

CALL JOPEN

a) Open a new picture

PIC (Wnt) = OPENPICURE (HIRESrD)

b) Set the origin to the bottom left comer of the picture frame

CALL SETORIGIN(INT2 (0),- (HIRESRE i.BrrTxT - HIRESRECr.7%0))

CALL JPAUSE

If not in the REPeat command, wait for a button click

IF (RFI)X) RETURN
DO MILE (.NOT. KTION)

10



CALL JSXZE (CXSIZE,CYSIZE)

Change the text size of the current font - ignores CXSIZE as the aspect ratio of the
characters cannot be changed in QuickDraw

SIZE = ININT(CYSIZE * SCALEI
CALL TEXTSIZE (SIZE)

CALL JWINDO (tIMIN, UMAX, VMZ,VMX)

a) Set the picture frame rectangle

HIRESRECT.TOP = 0
HIRESRECT.LEFr - 0
HIRESRCT.RIGHT = InInT( (UqL - tL)IN) * 300)
HIRESPREC.BrrTIU. INIWr((V1z4AX - VMIN) * 300)

b) Set the graphics window rectangle
OcG = JQDGBALSO( !GET QUICQRAN GtBALS

C SET WINDOWROCT TO SCREE DIMENSIONS
WINDOWRE = DG. .SCREEKBITS. BUMHS

C CALCULATE ASPCT RATIO OF PICT(JRE FRAME AND SCREN
RATIO = (UMAX - 11411N) / ('*WAX - 'A.DN)
SRATIO = FLOMT (WINORECT .RIGHIT - WNDU ECr.uET - 8)/

1FL0AT (WNDO1WRC.BOTrQ4 - WIN[OWRECT.TOP - 44)
C IF ASPECT RATIO OF PICTURE > SCREEN TMN MJE WINDOW4 SHALLDVER THAN
C SCREEN AND OFFSET wrND~wS DO&~, rTAE W~E IN1)CW NARREAER THA4N SCREENJ
C AND OFFSET W'INDOW.4 TO THE RIGHT.

IF (RATIO GCT. SRATIO) THEN
WINDOWRECT.TOP =WINCCN1RECT.T0P + 40
WINDOWRBCT .IEFT - INDORE2T .r + 4
WINIOWRtflT.RIGHT = wI)N1~qRSET.RiiT - 4
1gINDCWRSET .HCOT = ININr (F1tOT (WINDWRSET. RIGHT -

1WINUAMCT.IEFT) / RATIO) + WNDUAXRCT.TOP
HOFF'SET = 0
VOFFSET = 20

WINDlWREZI .TOP = WIN1MX2)T.TOP + 40
WINDOPREr .LEFT = WINDXNRFCT.LEFT + 4
WINDORFOCT .HBYT'Tt = WINDXWRECT .BTTC4 - 4
WINOWRE)C. RIGHT = fl4INT (FL0T (WINEO&RECT. BrI'C -

1 WINDWERCT .TOP) * RATIO) + WIHAREzr .LEFT
IiOFFSET = 20
%?FFSET = 0

b) Set the scaling factor to 300 dots per inch

SCALE = 300.0

6. COLOUR

To add colour, 'CWindows" were used instead of normal windows. "CWindows" are
based on "CGrafPorts" which allow full RGB colour control. The pen colour in a
"CGrafPot" is changed by the QuickDraw call

CAML FUIOLM (COLOR)

where ctouR is a variable of type R33cuR with a Language Systems Fortra structure:

INTEGER*2 REDl
nMD=*2GP
INTEGR*2 BLUE

END STR1JRE



Red, green, and blue specify the amount of each colour component ranging from 0 to
65535 ($0000 - $FFFF).

Colours were assigned to the eight individual line types used in TRANS for data plotting
by defining a new variable structure ciawuw (see Appendix A), as shown below, and
using a one dimensional array coim of that type with eight elements to record the RGB
colour values together with a text description of the colours for each line type.

STRUTUtREcoup.APM. /
CHARACTR*9 TEXT
RECMa/RGECOLOR/ C

In addition, a separate variable of the same type was used to return the pen colour to
black after the coloured lines were drawn (all borders, scales, and text were left black).
The default colours were initialised in data statements, shown below, and passed to other
subroutines through a common block, also shown below.

RECORD/COLORARAY/COIfOR (8), BLKCOL
C1MOCfNIOL/aOCOR, BU=L
DATA CDLOR(I).TEXT/'BLAK '/,COOR2) .TEXT'RED V/,

1 cOLOR(3) .TEXT/'GR/ EN '/,COLR(4) .TEXT/'BJJE '/,
2 COLOR(5) .TEXT/'CYAN '/,COLOR(6) .TEXT/'A. ENTA /,
3 CIflR(7) .TEtCI'YELLcIW '/,COLOR(8) .TEXTI'ORAN( 'I
DATA COLOR(l).RGB.RD/S0000/,COIf.R(1).RGB.Et I/$0000/,OfLR(1).RGB.BIIEIO0001/
DATA COLOR(2).PBS.RED/$FFFF/,COLO(2).RGB.G /$0000/, COLtR(2) .1G.BUJE/S0000/
DATA COILR (3) .RGB.RED/$0000/, COLOR (3) .RGB.GREEN/$FFFF/, COLOR(3).RGB.BUJE/$0000/
DATA COI.R(4).B.RED/$0000/,COU.(4).RG.GIEt2/$0000/,OOU)R(4).RB.IJE/SFF F/
DATA COLR(5) .R.RED/$0000/,COLOR(5) . B. GENSFFF/, COOInR(5) .P.BU'E/$/FF
DATA COLOR(6) .GB.PE/$FFFF/,COLO3R(6) .. GR.EEN/$0000/, COLOfR(6) .RG.BUJE/$FFFF/
DATA COLOR (7) .PG.PdI/$FFF/, COLOR (7) .RG.( EEN/$FFF/, COLOR (7) .RGB. BUE/$0000/
DATA COLOR (8) .FB.RED/$FFFF/, COLOR (8). R.GIEEN/$61A81, COlOR (8) .RGB.BUJE/$00001
DATA BUCOL.TEXT'PBC 'I/
DATA BBL.UIG3B.PD/$OOOOI, M.DOL. RGB. GREW$/SOI L. R.BW E/$O000/

To change the default colours, code was inserted into the section of Subroutine TRAN2
dealing with the PLS command. This code worked on the principle of reading a line
number and colour typed on the keyboard into a character variable as a response to a
prompt, extracting the number to identify the line, and comparing the text description of the
colour to those of the various colours shown above. For example:

TYPE 333, (COLOR(I) .TEXT, I=1, 8)
333 Fo0RT(IX, 'THE C n LINE COIORS ARE:',/

1 IX,'0 & 1 2 3 4 ',/
2 IX,4A9,/
3 IX,'5 6 7 8 ',/
4 1X,4A9,/
5 IX, 'AVAILABLE CO1JFRS :/
6 IX, 'BLACK, RED, GREEN, LTMME , BLUE, LTBUJE, CYAN, 'V
7 IX, ' 2TA, PURPLE, YELLOW, ORANGE. '/
5 IX, 'DO YOU WISH TO OiANm2 THE CO1IJRS. ,$
AC ZPT 334, ANSWER

334 FORMAT (Al)
IF ((ANSER .NE. "Y").AND. (ANSER .NE. "y")) GO TO 336
TYPE *, 'LINE COIRO'

339 CONTINUE
READ(5,'(A)') ClLSTR
IF (COLTR.Q.") GO TO 340
COISTR - ADdUSTL(COLSTR) !'R04E LEADING SPACES
DO I-i,LEN(TRIM(OLSTR)) !FIND PCSITION OF COU+%

IF (COISTR(I:I) .EQ. G, ') O TO 341
END1DO
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341 READ (ISTR (1:I-1), *) II !READ TIE IE NL14BER
IF(II.E.O) II = 1

TYPE *, 'ONLYj LINE TYPES 1 M0 8 EXIST'

GO TO 339
END IF
ccLcfR(i) .TEx(T - AojuJsTL(68IsT(I+1:)) !CHANG THE TM DESRIPTION
SELECT CASE (CCLOR(II).TEXT) !CHANGE THE COLOUJR

CASE C BLACK 1
68ILR (II) .RG.RED = $0000
CCILOR(II).GGRE - $0000
68IflR(II) .R.fLJE =$0000

CASE ('RED 1

CfLOR(II).GGRE - $0000
COL0R (II) .RGB.BLUE = $0000

CASE('68EEN
CfLOR(II).RB.E = $0000
61LOR (II).RBGRE = $FFFF

OLOR(II) .RG.B~LJE = $0000
CASE ('BLVE

6ILOR (II).RB.E = $0000
681LOR(II) .RG.8EN = $0000
COIOR (II) .RG.BU = $FFrF

CASE~ C )
COLOfR(II).GRE = $0000

COIOR (II) .RGB.GEE2= $FFFT
COLOR (II) RB. BLUE =$FFFF

CASE ('KNA, )
OflIflR(II) .RG.ED = $FFFF
68WR(II) .RLGB.GREE = $0000
OOIfOR(II) .RG.BUE = $FFFF

CASE ('YOW ')
CO1L0R(II).G.RED = $t
COLR (II) . G. GEEN4 = $FFFF
COLOR(II) .RGB.BUE = $0000

CASE('RNG ')

ODLOR (II) .RG.RE = $k-
OOLDR (II) .RIB.GEEN = $6000
68IflR(II).RG.BUE = $0000

CASE (PURPE ')
axnR(II)R.RD~ = $80E8
C0IflR(II) .RG.GEE2 = $0000
COLR(II) RG.BLJE = $FFFF

CASE (LTBUJE ')
COLOR(II).GRE = $0000
CILOR (II) RG-RE = $9C40
CfLOR (II) .RG.BUE = $FFFF

CASE M'TGREEN ')
COL0R(II).RB.E = $86B0
COLIR(II).GBGRE = $FFFF
COLR (II) R. BLUE = $0000

CASE DEFAULT
TYPE: *, '?:Yr A VALID CO8WjR'

GO TO 339
340 COTINUE
336 CTINMJ

The sections of code where the pen colour was actually changed with calls to
ptG1'oreo1or are set out in Table 4.
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TABLE 4
Sections of Code Where Pen Colour is Changed

Section Subroutine

Repeat Line Key REP command section of
TRAN2

Plot STRIP

Overlay Line Key GRID

7. PICT FILES

PICT files are the standard Macintosh files for transferring graphical data between
programs. The PICT file format (see page 85, Vol 5, Ref. 6) consists of a 512 byte header
followed by opcodes which contain QuickDraw picture information.

PICT files were used to store the plots generated by MacTRANS because they can be
read by most commercial graphics software, thus removing the need for a graphics editor
within MacTRANS.

In MacTRANS, two separate subroutines were written for saving pictures to
(Subroutine PICSAVE), and retrieving pictures from (Subroutine LOADPIC), PICT files.
The procedures for these subroutines are shown below.

7.1 Procedure Used to Save a Picture in a PICT File

a) Get the current volume number

OSERR = GTVOL(NIL,%REF(VREN"))

b) Create a new file
OSER = CREAE (FILENAW,VPEFN 1, CEAT, FILETYPE)

c) Open the new file
OSERR = FSOP l(FflAE,VREFt, %REF (FlMo))

d) Set the file marker to the start of the file
OSERP = SETFPOS(FIILNO, FSF RTAtr, INT4(0))

e) Write 128 integer*4 zeros to the 512 byte header - the header was not used to store
any information

DO I = 1,128
COUNT = 4
OSERR = F3%AITE (FILENO, %REF (CUNT) , %LOC (ZEM))

ENDDO

f) Get the size (in bytes) of the picture in memory
OUNT = GETHANDLESIZE (PICTURE)

g) Dump this number of bytes starting from the address of the picture into the PICT file
OS = F'RITE (Ffl, %REF( (UNT, PICTURE.PICH-.PICP)

h) Close the file
=SERR - FSC2SE (FIL=)
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i) Flush the volume buffer
OSR= rtILUSHOL, VRE")

7.2 Procedure Used to Retrieve a Picture from a PICT File

a) Call the Macintosh Toolbox standard "Get File" dialog box
CALL SFI TFIIE (WMERE, NIL, NIL, NLUIMYPES, TYPEIST, NIL, %REF (REPLY))

b) If the dialog box succeeds in selecting a PICT file, set the volume to that where the file
is located

IF (REPLY.GOOD) THEN
rILENAHE = REPLY.FNAHE
OSERR - SETOL(NIL, REPLY.VREPFN14)

EN D IF

c) Openthe file

OERR = P*SOPEP CREPLY.FNAME, REPLY.VREFRI, %REF (FLEN))

d) Get the size of the file

OSERR = GETEOF (FIIf, %REF (CONT))

e) Subtract 512 bytes from the size of the file

COUNT = OUNT - 512

f) Create a new handle for the picture
PICTURE.PICH = NDLE(CmiNr)

g) Lock the picture handle

CALL HLOCK (PICTURE)

h) Set the file marker to the start of the picture information

OSERR = SETFPOS (MIIO, FSFOC]TAMT, INT4 (512))

i) Read the picture information into memory

OSERR = FSREAD (FII , %REF (CCUNT), PICTURE.PICH
^ 

.PIQ')

j) Unlock the picture handle

CALL HUNCK (PICTURE)

k) Close the file

OSER = FSCIaSE (FIUI)

I) Flush the volume buffer

OSERR = FrJSHVCL(NIL, REPLY.VREFNt14)

8. EVENT-LOOP

In a Macintosh application, an event-loop examines the events that occur while a
program is executing, e.g. mouse button "clicks" and menu item selection, and calls the
relevant subroutines to provide the appropriate actions.

In this conversion, full use of the Macintosh operating system through the event-loop
was not made, as this would have needed a considerable amount of code rewriting.
Instead, a limited event-loop with the features of moving windows, opening and closing
PICT files, and printing was added to the end of the program so that it is only entered just
before the execution of TRANS would normally finish.
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This means that MacTRANS operates in almost exactly the same fashion as TRANS
does, but at the end of the program, allows all the graphics windows produced during that
run to be viewed on the screen at the same time, moved around, printed, etc. Plots created
from previous runs can also be opened in the event loop, and for the cases when it is
desired to use MacTRANS solely to view existing plots, a switch was added to the start of
MacTRANS to enable the program to skip straight to the event-loop, by-passing the
plotting prompts.

The Language Systems Fortran compiler also automatically adds a very limited sort of
event-loop around the entire program. This provides an output window for the program
input/output and, after the program finishes, provides menus which allow the user to first
edit and print the text in the output window, and then rerun the program. This event-loop
is not discussed here. For further information see Ref. 4.

The event-loop is handled by five subroutines: Loop, EventHandler, Do-Menu, SetUp,
and Open-Win. These subroutines are based on code used in the example program
"EventLoop" supplied with Language Systems Fortran. Loop contains the main loop
which detects the events as they happen. EventHandler is called from Loop whenever an
event is detected. It determines what type of event it is, and calls DoMenu or OpenWin
and/or Macintosh Toolbox procedures to perform the required actions. DoMenu
determines which menu item was selected and does, or calls other subroutines which do,
all the actions required by the menu selections. Similarly, Open-Win does, or calls other
subroutines which do, all the actions required by window events. It has several entry
points to it which in essence makes it a composite of several subroutines, each dealing with
a different window action (see Section 8.5). SetUp is the subroutine that creates all the
menus for the event-loop.

Three menus are used in MacTRANS: an Apple menu for the About MacTRANS dialog
box, and access to the desk accessories; a File menu for opening, closing, and printing the
PICT files and associated graphics windows, and for quitting the program; and a Window
menu for selecting the graphics windows, i.e. bringing them to the front. The Apple and
File menus are defined in the resource fork of MacTRANS, along with the icons for
MacTRANS and the PICT files, and the dialog box brought up when the About
MacTRANS item is selected from the Apple menu. For details on how the resource fork of
MacTRANS was added, see Section 10.

The variables dealing with the graphics windows are passed into the event-loop part of
the program via common blocks. Specifically, these blocks are:

RECIPD /F=XT/ WINIXRW1, HIPmSRur
/1Kt /RP S/WInDGoF=, HIRFZSRET

RECOM /OAnqXP7R/ NPTR(20)
INTEGR*4 INNU4
CM" /WINS/ WPTRWIM
MOORD /PICaAWLE/ PIC (20)
OMM /PICrURES/ PIC

WindowRect and HiResRect are the rectangles bounding the graphics windows and picture
frames respectively. These are used when PICT files are opened and displayed. Pointers
to the graphics windows are in the array WPTR, and handles to the pictures in the array
PIC (PIC(l) corresponds to WPTR(l), etc.). Winnum is an integer equal to the number of
graphics windows.

A brief description of the code used in the event-loop subroutines to perform the actions
required follows.
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8.1 Subroutine Loop
a) Calls SetUp to create menus

CAML SETUP

b) Frees the memory used by SetUp
CAL tUNIaV)SEG ( (SrL='

c) Sets the event mask and flags which indicate if Quit or Exit have been selected
EVrENT MSK = $FFFF !ALL EVENTS

DOE - .FALSE. !EXIT TO OUTPUT WINS : FIAG
FINDER = .FASE. !QUIT TO FINDER FLAG

d) Enters the event-loop
DO *=IE (DONE = .ALSE.)

A?_NT -r a MMMVE (VEN M1SK, %RF (THERVENT))
IF (ANEVENT) CALL EVNrHAMDIER (THEEVI, DONE, FINDER)

END DO

e) After leaving the event-loop, quits the Language System Fortran event-loop if Quit
was selected

IF (FINDER) CALL EU ('FIL
'
, 'QUIT')

8.2 Subroutine SetUp

a) Get the Apple and File menus from the resource fork of MacTRANS, add the desk
accessories to the Apple menu, and create the Window menu

APPLE~MErU.MtMrH L24 RAPPLEID)
CALL INSER1MENU (APPLEMEERU, ZERO)
CALL ADDRE34NU (APPUMt, 'DRVR')
FIIEMNU.MtUH = GETHENU(FIIEID)
CALL D1SERMENU (FIfENJ, ZERO)
WnMMEHNUH = NtX'EtUMN4ENMI,WnMU4ttIT)
CALL IfERThU (WNENU, ZERO)

b) If no graphics windows are open, then disable the relevant menu items; if there are
graphics windows open, then add their titles to the Window menu

IF (WINNT1s .EQ. 0) THEN !IF THERE ARE NO EXISTIND WINDOWgS
CALL DIBSAIEmr (FIIZMEN, INT2 (2)) !C= E
CAL DISAmBIETE (FILME, roT2 (4)) ! PRINT
CALL DISABILIT(FIEMtU, INT2 (5)) !PAGE SETUP
CALL DISABII KDMt, INT2 (0)) !W
CALL HILITf ENU(ZER0) !THIS UN-HIlMHTS ALL MENUS
CALL FISHEVENTS ($FFFF, ZERO) !STAA FRESH ON EVENTS

ELSE IF THERE ARE EXISTING WINDOW AD TH 14 TO THE WINDOW MENU
DO J = 1,WINm,,

CALL GETWTITLE (WTR(J) .WP, WINMENTIT)
CALL APPENMEN-U WINMENU, WINMENTIT)

END DO
END IF

c) Send the output window behind the graphics windows and draw the menu bar
CALL SENDBIND (WrPUTM () ,NIL)
CALL DPAM12tBAR

8.3 Subroutine EventHandler
a) Get the QuickDraw global variables and set the exit flag to false

G= OAIS(
DONE FALE.
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b) Determine the type of the event and perform, or call the appropriate subroutine to
perform, the required actions

SEEC CAS TEE NT~.W{AT)
CASE (MOSDW)

WINDWAJR, T = FIDNVDOF(WT TMfVEN.WHEE, %REF ,(W))
SELET CASE (W D A )

CASE (IDWtSY AR) !I sBs
CALL, DO MEN OMUSLELT (ENT.MEE) ,DCNE, FIf)

CaSE tI)~ywffl ) !IN SYS WIDO
CALL SYSI'DCLIQK (THEVENT, WrnP)

CASE (INOOrT2Nr !CONTEN REION
IF (WIN.WP .NE. FRNTflNX ) CA[L SE ,MIN(WINP.WP)

-R) WINP.WP
IF ((WR RD .WINOcMEIND .NE. OSERKIND).OR.

I WINP.WP .EQ. C0TPUTWINO))) THEN

CALL DISABEITD4M(FIL M, INT2 (4)) !PRINT
CALL DISABIEITE4(FILEENU, INT2 (5)) !PACE SETUP

ELSE
CALL ENABLEITE4 (FIU2EM, INT2 (4)) !PRINT
CALL DNBLEITEM(FflENU, INT2(5)) !PAGE SETUP

END IF
CALL DRA1ENUBAR

CASE (INDRAG) !DRAG REGION
IF (WINP.WP .NE. OUTPUTWIN4OW() THEN

IF (WINP.WP .NE. FmONTWINDOc) CALL SELECThINDOKINP.WP)
LIrITRECT = QDG^. SCREENBITS.BOWJDS
CALL DRAGIND W (WINP, THEEVEM. WHERE, ITRET)

END IF
CASE (=;CM3) !SIZE REGION
CASE (f W) !CLOSE BOX

IF (WINP.WP .NE. cxyrPUTfWINDOWO) THEN
C.OSEIT = T(3WIP, THEENT. WRE)
IF (CLOSEIT) CALL C=LoSWIN(WINP)

END IF
CASE DEFAULT

! NO OTHER WI DOW PARTS TO DEAL WITH.
END SEIECT !END OF MEDW EV T.

CASE (MUJSEUP) !MOUSE UP
!THIS PROGRAM DOES NOTHING IN RESPONSE TO THIS EVFNT.

CASE ( EY ) !KEY PRESS
CHOODE = JIAND(THEEVENT.MESSAGE,CHARCOEKSK)
CH = CHAR(O1:ODE)
CHOE = JIAND (THEEVINT.MODIFIERS,CMDKEY)
IF (CHOOE .NE. 0) CALL DOMENU NENUKEY (CH), DOE, FINDER)

CASE (CEYUP)
THIS PROGRA DOES NOTHING IN RESPONSE TO THIS EVENT.

CASE (AUTKEY)
!THIS PROGRAM DOES NOTHING IN RESPONSE TO THIS EVENT.

CASE (UPDATEEVT)
CALL REDRAW WIN(THEEf .MESSACE)

CASE (DISFG )
THIS PROA DOES NOTHING IN RESPONSE TO THIS EVENT.

CASE (ACIVATEEVr)
CALL SETPCT (THEEVE .NFSSAGE)

CASE DEFAUJLT
END SELECT

8.4 Subroutine Do Menu

a) Determine the menu and menu item from the first argument in the cal! to Do-Menu

P - 32767

IF (NCICE > 0) THEN
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ITE4 = JI AND MA2XOCICE, PORr0TP) !EXTRACT THE MENCJ & ITE M Nt1BERS
= JIsHFT (0k.HOIc, -16)

b) Perform the appropriate actions based on the menu and menu item

IF 04M = 1) THEN !APPISZ .
IF (ITE - 1) THEN !ABOUT EVENTLOOP

C SINE DPTR IS NV GOIN TO BE DERFlW), IT CAN
C JUST BE AN INTEGER*4

DPTR = GEI'NEDIALG(INVT2(13748),INT4(0),-1) !DIALG RES TD = 13748
IF (DPTR NE. 0) THN

CALL GETPOP (%REF (PETMIP))
CALL SETPOW (DPTR)
CALL DRANIDAW3 (DPTR)
DO ffIfI (,NDT. BRI"17)
END DO
CALL DISPOIAIOG (DPTR)
CALL sErPmP (PCt-IT)

END IF
ELSE !ITEM IS A DESK ACCESSORY

CALL GETIT24 (APPLZ4NU, ITE4, %REF (ITMSTRING))
CALL GETPORT (%REF1OLDPORT))
TEW = CPENDESKIQ (ITE)TRflG)

CALL SETP0FC (OLDPORT)
ENDIF

EaSE IF (NEU = 2) THEN !FILE NU
IF (ITE4 = 1) TH N !OPEN

CALL OPEN WIN
ELSE IF (ITE - 2) T1M !CUDE

VINP.P = FROTWINDW0
CALL C7E WIN (WN)

ELSE IF (ITEM - 4) THEN !PRINT
WINP.WP = FRONTWINDOO

WNU4 = X (WINP.WP)
CALL PRINTPIC (PIC (UM), HPRINT)

ESE IF (ITE 5) THEN !PA SETUP

CALL PAGESEUUP (HPRINT) !MOIFY PRINT RECORD
SE IF (ITEM= 7) THN !EXIT TO OUTPUT WINDW
DUE = TRUE.
WINP. P = FIRITI'NDOW0
CALL CLOSE ALL WIN

ELSE IF (TER - 8) THEN !QUIT TO FINDER
D(E = .TRUE.
FINDER = .TRUE.
CAIL CLOSE ALL WIN

ENDIF
ELSE IF (MNU = WINMUI) THEN !WINDOW MNU

CALL SELCTWINOW (WPTR(ITR),WP)
ENDIF

ENDIF

c) Turn off the menu bar highlighting
CALL HILITEMJ (INT2 (0))

8.5 Subroutine OpenWin

Subroutine OpenWin has several entry points which are dealt with separately below.
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CALL OPENWIN

a) Set the true and false variables and increment the window number
FIS = .FALSE.
TRU= .TRIJE.
WINNUM = WINI + 1

b) Check if too many windows will be open
IF ('lNMtO > 20) THEN

CALL AEIRT(ox('Yo0 HAVE EcE]DE THE mxnm NUMBER OF w Inc . ')
WINNtM 10
GO TO 10 !RETURN

END IF

c) Load the new picture from the PICT file
CALL LMDPIC (PIC (WneOM), WNTrITLE, ERR)

d) Append the window title to the "Window" menu
CALL APPEN4EtNU K(Nt, WTITITLE)

e) Calculate the window size
QDG = JD 0BAIS(0
WIN1OWRET = CG SCREEITS.BUNDS

C CAICULATE ASPECT RATIOS OF PICTURE FRAME AND SCREEN
RATIO = FIT(PIC(WINNrI4).pICH^.PICP^ PICRAME.RI(H -

1 PIC(WINN) .PICH(^ .PICP^.PIC(RAHE.LEFr)
2 / FIAT (PIC (WINNJ) pICHA.PIC^PI RAr.BOTXM
3 PIC (WIN ) .PICH^ .PICP^.PIC.RAETOP)

SRATIO = FILAT (WINDTWRr.RIiHT - WIflmWRE.LEFT - 8) /
1 FIfAT(WT.NRE~r.BOTT1U4 - WI.DORECT.TOP - 44)

C IF FRAME RATIO > SCREEN RATIO THEN MAKE WINDOW SHALIOWER THAN SCREEN AND
C OFFSET DOW OTHE SE ME WINDOW NARpPER THAN SCREEN AND SET OFFSET TO
C THE RIGHT

IF (RATIO .Gr. SRATIO) THEN
WINDOWRECT.TOP = WIN! RtET.TOP + 40
WflD Rr. LEFT = WINDcMRECr.LEFT + 4
WINDOWREr.RIGHT = WINOWR.RIGHT - 4
WINDOCR .BOTTrM = ININT(FIflT( .WINORET.RIGQT - WINDWRET.LEFT)

1 RATIO) + WINI.DOWE.TTOP
HOFFSET = 0
VOFFSET = 20

WITDORECT.TOP = WINDOWREC.TOP + 40
WINDCRE~r.LEFT = WINDC.REXcT.LEFT + 4
WINDO RECT.BOT7IOM WINDOWRE .BOTTOM - 4
WINDOWRCT. RIG(T = ININT(FI.LAIT',WIND,REz'T.BDTITiC - W'DWRF-T. TOP)

I RATIO) + WINDCV.RECT.LEFT
(OFFSET = 20
VOFFSET = 0

ENDIF

f) Open the new window
WPTR (WINU) .WP = NEWINDOW (NIL, WINDWR DT, WINTITIE, FIS, NOG DXOPR(C,

1 INFRONT, TRI, W11""
g) If the new window was opened, calculate the offset, move the window, make itvisible, make it the current window, and enable the relevant menu items; otherwise,

send an error message and decrement the number of windows.
IF WTR(WN .WP .NE. NIL) THEN
HGLOB - (WM - 1)*HITSET + WII1XJWRZT.IE-T
Va m - (WI -tm - 1)m m + m lmmm m l m m
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CALL M=DV OW (PTRI (W1UMM) .W, HGICB,VLOB, FLS)
C THE WINDOW WAS INITIALLY INVISTRIE SO IT COULD BE MtOVED BEFORE BEING SHOW

CALL S W TR(WPR I ) .W)
CALL SETPO(T (PTR (WINNUs) .WP)
IF (NINHE?! = 1) THIE ! IF THIS IS THE FIRST WINDOW ENABLE THE MtENS

CALL ENABI.EI'T (FIIaEO, INT2 (2)) CLOSE
CALL ENBLEITE (FII.~U, INT2 (4)) PRINT
CALL ENBEITE (FIU24EN( , INT2 (5)) !PAGE SETUP
CALL E2ABLEITEM PM44UM, INT2 (0)) !WINDOW

ENDIF
CALL DRA MMENUBAR

ELSE

CALL ALERT3X ('THE WIN COLD NOT BE OPENED. )
WINNtI4 = WINNtI4 - 1

ENDIF

CALL CLOS _W3N (CLWVI)

a) If the window selected is the output window, do nothing

IF (CLWIN. NP EQ. OWrPUTINDO ) RETURN

b) If the window selected was created by the program

IF (CLPEEK' .WINDOKIHD = USERKIN) THER

then do (c), (d), (e), and (f); otherwise, do (g)

c) Move to the selected window, hide it, dispose cf it, and release the memory used by
the picture associated with it

CALL SETPORT (CLKIN.W)
WNtlM = GNREFC(CLIN.WP) FIND OUT WHICH WINrV"
CALL HIDEK'INDI(1 (CtMIN. WP)
CALT. DISP ((INDOW)GJIN.WP)
cU..L KILLPICTJRE (PIC (M))

d) If it is the last window, go to (e), otherwise, renumber the windows and pictures to fill
the space

IF (W-1t4 = WINNUM) GO To 6 !IF IT'S TH, LAST WIHIX
C OTMHEISE MOVE THE HIGHER WINOWS DOW TO FILL Irti 3-ACE

DO 5 J=WNUM, (WINNUJ-1)
WPTR(T) .WP = NPTR(J+1) .WP

PIC(J) - PIC(J+1)
CALL SETREFO (WPTR(J) .WP,J)
CALL (7WrITLE(WPTR(J+1), %REF (WINTITLE))
CALL SEIWTITLE (WPTR (J) .WP, WINTITIE)
CALL SELECI1INDOW ( (PR WI") .WP)

5 CONTINUE

e) Decrement the number of windows

6 WINt k= WINNM - 1

f) If no windows are open, then disale the relevant menu items; otherwise, remake the
"Window" ire j

IF (WINNL'l = 0) THN !IF NO WIN OPEN DISABLE MENJUTS
CALL DISABLEITEM (FILflEU, INT2 (2)) !CE
CALL DISAtLEITE4(FILEMENU, INTS (4)) !PRINT VERT
CALL DISABLEITM (FII MEU, INT2 (5)) !PRII HORIZ
CALL DELE2E J (WINENID)
CALL DISP Sf2ENU (WNMU)
WIHENU.M.ENH - NEIMEW(W'*ENIDWINMENTIT)

CALL INSERTM umru(SEJ, Inm2 (0))
CALL DISABaErTD(WINKNJ, INT2 (0)) !TUI OFF WINDOW MEW
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CALL DRAWMENUBJAR
ELSE !R FIJRE WINDOW MENU

CALL DELE (Wl,')
CALL DISPOSMENU (WNMENU)
WI.2IUN.2UH = N5H 4ENUt(WI~2 ID, w 4rIT)
DO J=1, WDrM

CALL (GEIWrITLE (WPTR (J) .WPWINTITLE)
CALL APPEUNU (WINNU, WINTITLE)

ENDDO
CALL INSERaMtJ (WINMNt, INT2 (0))
CALL DRA14EHUBAR
CALL SETP (FRONWIN )

ENDIF

g) If the window selected was not created by the program, send it behind the other
windows

ELSE
CALL SENDBEHID (CIN, NIL)

END IF

CALL CLOSEALLWIN

a) Close all the graphics windows

DO 15 J 1,WNNuM
CALL SETPORT(RPTR(j) .WP)
CALL HIDEWINIX (WPTR(J).P)
CALL DISPOSEOINE)(WPTR(J) .WP)

15 CCaTrINUE
h) Set the number of windows to zero

WINNt = 0

c) Disable the relevant menu items
CALL DISABLEIT4 (FILEMU, INT2 (2)) !CISE
CALL DISABLEITEM(FII8MNU, INT2 (4)) !PRINT
CALL DISABIITEM (FILIMEN, INT2 (5)) PAE SETUP
CALL DRAE21UBAR

CALL REDRANWIN(CLWIN)

a) Get the current window

CALL GTPORTR(REF (OLDPORT)) !REEMBER CURREN4T PORT

b) Move to the window to be redrawn

CALL SEIPORT (CLKlN)

c) Erase and redraw the window

CALL BEGNUPDATE (CIWIN)
IF (CLkJIN.WP .NE. Oaxr(uWINM)O THE

TEPET= CI.MIN.WP PORTC
CALL E (TE T)
WNUM - GI4-REFOON(CIMIN) !GET THE PICTURE NUMBER
CALL DRAWPICTURE(PIC($R1NtM),TEPRECr) !RE)RAW THE PICTURE

CALL F DPAWTYPPINDXv
CALL DRA1 OTI~aS (Qafl4)
CALL DR MWCON (CLWIN)

END IF
CALL HDVPD.nE (CLIN)
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d) Move back to the original window
CALL SETPOW (O )

9. PRINTING ON THE APPLE LASERWRITER

In this conversion, the usual printing procedures were adopted, i.e. the selection of
Page Setup and/or Print from the File menu. These menu items are handled by three
subroutines: PrintPic, PageSetUp, and CheckPrintHandle.

CheckPrintHandle is called by both PageSetUp and PrintPic to check that the print
record (Hp rn) passed to the subroutines is valid. If it is not, a new print record is created
and the default print settings from the printer resource file are assigned to it.

PageSetUp allows the default print setting to be changed. by calling the standard page
set-up dialog box.

PrintPic prints the picture with the print record settings passed to it. It sets the
LaserWriter resolution to 300 dpi, adjusts the print rectangle to the same size as the picture
frame, positions the print rectangle to allow for adequate margins on the page (which
depend on whether the page is printed vertically or horizontally), and calls the standard
print dialog box to set the number of copies, pages, etc.

A brief description of the code used in the printing subroutines to perform these actions
follows.

9.1 Subroutine CheckPrintHandle

If the print record is non-existent, create a new one and assign the default print settings
to it; otherwise, check the record to ensure it is correct

IF (HINT.TH .EQ. NIL) TH !IF PRItr NON-EXISENT
HPRINT.TH = NEV-ANDLE(INT4 (120)) !CREATE1 A NW HANDLE FOR NPRINT
CALL PRINTDEFAULT(HPRINT) !SET THE DEFAULT VALUES FOR THE PRINTER

EE VALIDATE EXISTING PRINT REORD
IF (PRVALIDATE(HPRINT)) THEN !CMEC RECORD AND ADJUST IF NECFSSARY
SE !NO ADJUSTMENr NECESSARY

EMDIF
ENDIF

9.2 Subroutine PageSetUp

a) Open the print manager

CALL PROP

b) Check the print handle

CALL ECPRINTHANDLE (HPRINT)

c) Call the stadprd page set-up dialog box
IF (PP.STLDIAL (HPRINT)) TH
D IF

d) Close the print manager
CALL PRCILQE

9.3 Subroutine PrintPic

a) As for PageSetUp

b) As for PageSetUp
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c) Set the LaserWriter resolution to 300 dots per inch
SPRDATA. IOPOOE =5

SPRDATA.HPRINT R PRINT
SPRDATA.D(RSL = 300
SPRDATA.IYRSL = 300
CALL PGAML (%LCC (SPRDATA))

d) Set the print rectangle - depending on the orientation
PRINTRCI = HPRINT .TH^ .TP^ .PRINFO.RPAGE !SET PRINT RC TO DEFAULT PACE

C OFFSET PRINTRCT TO ALOW FOR MARGIN - DIFm1
C AMDXJNT FOR VEFICAL OR HORIZON~TAL PRINTING

IF (HPRINT .THA .TpA .Pp .RPAGE.RIcHT .Gr.
1 iPPRIT. TP^.PPJNF.RPM.BrIU4) THEN

C RECALCUATE PRINTREr BrOO AN RIGHT SO THAT
C PRINTRECT IS SCALE TO FIT HEO.I'j0TAL FUM

PRINTRI'. BOrTld PRfINTRW.0'rIU - 200
PRINTRCT.RIGHT =PRINTRECT .LEFT +

1 INT (FT.W (PICT'URE. PICH^ .1 PP.PICFRAME. RIGHT -
2 PICIURE.PIH .PICP^ .PICFRAME.IEFr) /
3 FLOA~T (PIC .JRE .PIor .PIGPT .PIFRAME. BFtrl4 -
4 PIC~TURE. PICH. .PICP^.PIRAE. TOP)*
5 FIlU' (PRINTRE r.B2rII4 - PRINTRWDT.TC&'))

CALL CFFSETRECI (%REF (PRINTRT) , INT2 (0), INT2 (200)) !HORIZ PRINT OFFSET

C RECIUIATE PRINTRCT BOTTC AND RIGHT SO THAT
C PRINTRECT IS SAME SIZE AS PICTURE FRAME

PRINTRr .BO11U4 = PRINTRr .TO + PIC'IURE.PICHr PICP .PICFRAME .BrC4 -
1 PICTURE .PICHA .PICFP .PICFRAME.TIP

PRINTRI' .RIGHT = PRINTRET .IEFIr + PICTURE. .PIi^r.PIC^ .PICFRAME. RIGHT -
1 PICTU1RE. PICHr.PICP.PICFRAME.LEFT

CALL OFFSETRErI' (%RF (PRINTRI) , flNT2 (75) , 1NT2 (75)) (VEXT PRINT OFFSET
ENDIF

e) Print the picture
IF (PRJEDIAXX3 (HPRINT)) THEN !CALIS STANDARD PRINT DIALOG

CALL GTPMR (%RER (ODPRT) ) !GET THE OLD PORT
PRINTPORT. TP = PROENDO (HPRINT, NIL, NIL) !OPEN~ THE PRINTING, PORT
IF (PREROR .EQ. NORR) THEN !IF ND ERROR

Call SETPCRT (PRINTPORT. TP) !MWE PRINT PORT CURRENT PORT
IF (HpRINT. THA .TpAPR 0.7O~ EQ!X. EDRAFTI") THEN

lNtSPIES = HPRINT.TWH .TP^ .PRJCB. ItfPIES

NOPIES = 1
END IF
DO 100 CO)PIES - 1,NOOIES

CALL PROPENPAGE (PRINTPORT .TP, NIL)
CALL DRANPICTURE (PICTURE, PRInTr~ ) !DRAW PICTURE IN PRINT PORT
CALL PRCLOSEPAGE (PRINTPORT. TP)

100 COTINUE
ENQDIF
CALL PRCLOSD (PRINTPORT.TP) !CLOE PRINTING POW
IF ((HPRINT.TH^ .TPA .PRJ0B.BJDOCL0OP .EQ. BSP00LI"X) .AND.

1 (PRERO EQO. NOER)) THEN4
CALL PRPICFILE (NPRINT, NIL, NIL, NIL, %RE (PRSTAT) ) !SPOOL DOENT

IF (PRRC .ME. NOER) CALL ALERTROX C 'Prin~prrr.'
CALL SEPO (COW) ! OODPR

END IF

f') Close the print manager
CALL PRCOSE !CLOS PRINT MhNAGM
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10. RESOURCE FORK OF MACTRANS
The resource fork of MacTRANS was added using ResEdit Version 2.0b2, which

displays the various resources in their full graphical form. The resources were first saved
into a file named "TRANS.rsrc" and then this file was copied into the resource fork of
MacTRANS at the compilation stage (see Appendix E of Ref. 4).

10.1 Icons

The following steps were taken to add the icons for MacTRANS and the PICT files
created in MacTRANS (see Figure 1).

APPL icon PICT icon

Fig. 1 Application and PICT file icons

a) Create New Resource was selected from the Resource menu, and BNDL was selected
from the list brought up on the screen. This brought up two more windows, one of
which was titled BNDL ID.

b) "TRAN" was typed for the Signature (the Signature being the same as the Creator
given to MacTRANS when it was complied) and Create New File Type was selected
from the Resource menu twice. This brought up two sets of blank icons.

c) Under Type in the BNDL ID window, "APPL" and "PICT" were entered for the
appropriate icons.

d) The blank icons were double-clicked to bring up dialog boxes which prompt for the
icons to be used. In both cases New was selected to bring up a window in which the
icon was drawn, and these icons were then dragged into the Mask boxes to provide the
highlight masks.

10.2 Menus

The Apple and File menus (see Figure 2) were created with the following steps.

67 File

but MacTRNS Open XO
Close XW

Print XP
Page Setup XL

Exit to Output XE
Quit to Finder XG

Fig. 2 Apple and File Menus
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a) Create New Resource was selected from the Resource menu, and MENU was selected
from the list brought up on the screen. This brought up a new MENU ID window.

b) The menu items (with optional command key equivalents) and separator lines were
then entered.

10.3 Dialog Box

The dialog box brought up when the About MacTRANS item in the Apple menu is
selected (see Figure 3) was created using the following steps.

MacTRANS is a Macintosh
uersion of the program TRANS.

Modified bg D. M. Blunt.

Fig. 3 "About MacTRANS" Dialog Box

a) Create New Resource was selected from the Resource menu, and DLOG was selected
from the list brought up on the screen. This brought up a DLOG ID window in which
the size and position of the dialog box was set.

b) Create New Resource was selected from the Resource menu, and DITL was selected
from the list brought up on the screen. This brought up a DlTL MD window.

c) Create New Dialog Item was selected from the resource menu.

d) The text for the dialog box was then typed in and the Static Text button was selected.

11. HOW TO RUN MACTRANS

MacTRANS is launched by double clicking on its icon. This starts the program and
bring up the output window. The first prompt is:

Go STRAI ff T EVEt2I LC.P?

Answer No (a <CR> defaults to No) to continue on with the normal TRANS commands,
or Yes to go to the event-loop part of the program where existing PICT files can be opened
and printed.

11.1 Data File

The data file is entered in the normal way. Due to the extra extension involved with the
PICT files, however, it can only be up to nine characters long (excluding the .DAT
extension). Also note that the data file must be in Macintosh binary format (i.e. created on
a Macintosh or converted to Macintosh binary format), which is different to the binary
format on the Elxsi.
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11.2 Commands

The existing TRANS commands (see Appendix B) have not been altered and work
exactly the same as before, with the following exceptions:
i. The SPAce command no longer needs to be called to remove the space from the left

hand side of the plot as this is now the default. The space can still be inscrtcd f
required.

ii. The prompt for graphics output to the screen can be ignored as graphics will be sent to
the screen no matter what is answered.

iii. When graphics are sent to the screen, the program will wait for a mouse click to allow
the user to inspect the result.

iv. The EXIt command transfers control of the program to the event-loop, where the plots
can be printed, rather than exiting the program.

Note: Graphics output seen on the screen is reduced in size to fit the whole plot on the
screen. Text and lines may therefore look somewhat distorted. Also, if graphics
fail to appear on the screen, MacTRANS may have run out of memory. This can be
overcome by increasing the memory allotted to MacTRANS under Multifinder.

11.3 Colour
Each individual line-type, of which there are eight, is assigned its own colour which

can be changed at the time that the line-type is selected. The line colours can be changed by
answering Yes (a <CR> defaults to No) to the prompt

DO YOU WISH TO CHANZ THE COLSM? :

and entering the line number, a comma, and the new colour (spaces are ignored) after the
prompt

LIfE cODIOJR

e.g.

2,GMW~

A carriage return entered by itself will continue execution of the program when all the
changes have been made.

Note: When the PLO or REP commands are used with the default (0) line-type
specified, the first block will be plotted with line type 1, the next with line-type 2,
etc. The colours of these lines will be as set previously. When a line type of I is
specified, all the blocks will be plotted with solid lines but with the colours still
incrementing (as if 0 had been specified). Specifying line-types greater than I will
plot all the blocks with the same line-type and colour.

11.4 The Event-loop
The EXIt command moves control of the program from the output window to the

event-loop. This brings all pictures created from the current session of MacTRANS to the
front in the reverse order to which they were created, i.e. with the last picture on top.
These pictures can be manipulated in the usual Macintosh fashion; however, they cannot be
edited. If editing is necessary, it is easily accomplished in one of the commercial graphics
programs such as Canvas or MacDraw I.

Printing a picture is accomplished by selecting the window in which it is displayed
(bringing it to the front) and selecting Print from the File menu. This will print the picture
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at 100% real size with the default vertical (portrait) page set-up. A vertical page set-up is
only suitable for plots with a short time axis and no legend, i.e. those created with the PLS
command. The horizontal (landscape) page set-up is more suitable for plots with long time
axes, or plots where a legend is printed, but scales the plot down to approximately 70%
real size to achieve this. Table 5 sets out the maximum axes sizes for printing on an A4
sheet of paper using the LaserWriter.

TABLE 5
Maximum Plot Sizes in Inches

Command X Y

PLS (vertical) 5 8

PLS (horizontal) 14 8

PLO / REP (horizontal) 11 8

Selecting the Quit to Finder item from the File menu will quit the program completely
and return control to the Finder. The Exit to Output item in the File menu, however,
returns control of the program back to the output window.

The output window has its own set of pull down menus (created by the Language
System Fortran compiler) with commands that will save or print the contents of the
window, and also a command to rerun the program.

11.5 MacTRANS Example

The following example uses a data file created by the performance estimation program
Polar2 4, estimating the performance of an Iroquois helicopter.

[TRANS version date 12-FEB-91]

GO STRAIGHT 20 EVENT IX?
I/P FILEN = POIAR2
Pc1ar2
Iroquois Performance

I/P FILE RECOMED CN 14-JAN-91 AT 14:04:38

INTEGN INT - 0.OOOOE+0; RUN CPU TRE = 0.93 SEC.

TDE FRM 0.OOOOE+0O TO 1.0000E+02 IN STEPS OF 2.OOOOE+00

*PLO

IS GRAPHICS OUTPtf TO SCREN RByIRED :
[PIS/O Output, for this run, going to DSK:POIAR2.PL2 I

OVEPIAy PLOTS

BLYS
1,2,3,4,34

'4 "Polar2" uses velocity as the independent variable, thus references to tine are actually references to
jvelocity in knots.
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BLKS TO DETE FINE Y SCALE
1

TO SPECIFY NO. OF X LUITS/INCN, TYPE 0 FOR X

LENGTH OF AXES IN INCES; X, Y = 5,5
AIE SMLS REQRD Ft PLUS
LnE KEY (0 GIES DFAULT) =
THE CURREf LINE 00ILRS ARE:
0&1 2 3 4
BLACK RED G BLE
5 6 7 8
CYAN MA G YELUM CRA
AVAILABLE C S :
BLACK, RED, GR2EEN, LTIGREE, BLUE, LTBIEE, CYAN,

NGWNrA, PURPLE, YELO, ORFAGE.
DO YOU WISH TO CHANS THE OOIiJRS?
*GOE
** PUNNING *

*EXI

STOP

Figure 4 shows the graphics from this example as they would appear on the screen, and
Figure 5 shows the graphics as they would appear when printed on the LaserWriter when a
horizontal page set-up has been selected (this is necessary to include the legend which
would otherwise be clipped off).

6 File Window I 3:09:22il 
"

POLAR2.PL2.a

.----- _

Fig. 4 MacTRANS Graphics Window for the Polar2 Example

29



10.00 PLOT KEY

- - TOTAL

(Hp)

. - - -_ - PROFILE
(Hp)

--_.-__ INDUCED
(Hp)

6.00 PARASITE

Output N, 
(Hp)

Value COMPRESS

.10.2 (Hp)

4.00

---- ---- --- ---- -- --- -----

0.00 _____________________________

0.00 2.00 4.00 6.00 8.00 10.00
VELOCITY

(Kn)

Polar2

Iroquois Performance

Fig. 5 Graphics ror the Polar2 Example as Printed on the LaserWriter

11.6 Execution Time Comparison

To compare the execution times of MacTRANS with TRANS, the same data file was
processed identically by both programs. TRANS was run on the Elxsi at four different
loading levels, for which the number of time-sharing users provides a guide, and
MacTRANS was run once on a Macintosh lfx.

The data file was a recording of 34 channels, two of which were sampled at 40 Hz and
the rest a! 10 Hz, for a duration of 134.85 seconds. The processing consisted of using the
PLS command to plot all the non-zero channels, a total of 29, on the screen in four separate
plots, three with eight channels, and one with five channels. The results are set out in
Table 6.

It can be seen that the Macintosh Ilfx was faster than the Elxsi for all cases. As it is
normal for TRANS to be run on the Elxsi when there are at least 21 time-sharing users,
MacTRANS running on the Macintosh llfx provides significantly improved performance.
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TABLE 6
TRANS and MacTRANS Execution Time Comparison

Task TRANS MacTRANS
(Elxsi) (Mac Ilfx)

Number of Time- Time Time
sharing Users (min:sec) (min:sec)

Real time taken for 21 0:25 0:38
initial read of data 29 0:30
file 31 0:25

35 1:20

Real time taken for a 21 3:30 3:05
PLS plot of all 29 3:50
variables 31 4:50
(4 pages of plots)t 35 8:00

Total real time 21 3:55 3:43
29 4:00
31 5:15
35 9:20

Total CPU time 21 1:42 n.a.
29 1:42
31 1:46
35 1:47

TRANS and MacTRANS pause between pages so that the user can view the results. This is the time
taken with no pauses.

12. CONCLUDING REMARKS

The conversion of TRANS to MacTRANS was undertaken using a strategy which
required as few changes as were necessary to make the program operational under the
Macintosh environment. While this was successful, MacTRANS does not take full
advantage of all the Macintosh operating system features, and therefore there is scope for
improvement in this area.

The first step in implementing these improvements would be to make the event-loop
encompass the entire operation of the program, which would include making all the
keyboard entered commands associated with TRANS (PLS, PLO, SCA, etc.) menu items.
Other improvements that could be made include using a dialog box to select the data file,
making MacTRANS launch and display a PICT file simply by double-clicking on that file,
allowing the pictures to be edited in MacTRANS itself, and adding a zoom-in/zoom-out
facility to the graphics windows.

It has been shown that MacTRANS, running on a Macintosh Hfx, offers substantial
gains in operational speed over TRANS, running on the Elxsi, for the majority of cases.
MacTRANS also has advantages in the graphics manipulation area, with the ability to edit
plots produced by it in graphics programs such as Canvas or MacDraw 11.
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APPENDIX A

Compiler Switches, Include Files, and Procedures
Necessary for Calling the Macintosh Toolbox

This appendix briefly details the requirements for calling the Macintosh Toolbox
procedures. For more detailed information, see Ref. 4.

A.1 Compiler Switches and Include Files

The Language Systems Fortran compiler needs to know the trap addresses of the
Toolbox calls, the number of arguments each requires, and what type of result each
returns. This information is contained in the "inlines.f' file which is accessed by adding
the compiler switch

!!P InLines.f

to the start of any Fortran source code file using Toolbox calls.

Toolbox calls also use various Pascal records as arguments. As Language Systems
Fortran cannot use these records, it uses its own records which are defined in structures in
"Flnclude" files. In order to declare variables using these structures, the appropriate
"FInclude" files must be included in each subroutine using Toolbox calls, or a global
include compiler switch must be used at the start of each file containing those subroutines.
For example, a file containing a subroutine using calls to the window manager could
include the file "Windows.f" in the subroutine itself, or use a compiler switch at the start of
the file. The compiler switch is more useful, as it negates the need to place include
statements throughout the program, and one switch can access as many of the "Flnclude"
files as necessary. Language Systems Fortran provides a file named "Toolbox.finc"
which, when used in the switch

!!G Toolbox.finc

gives access to the most frequently used "FInclude" files.

"Toolbox.finc" is a file created from a dummy Fortran program that includes the most
frequently used "FInclude" files. However, it does not contain the "Finclude" files
"Fonts.f" or "Printing.f" needed for the calls to the font manager and print manager in the
DI-3000 JFONT routine emulation and printing subroutines. Also, the "FInclude" file
"QuickDraw.f', which is included in the "Toolbox.f'mc" file, does not have the structure
definition for "CWindows" needed for the Toolbox calls dealing with these windows, nor
the definition for the "ColorArray" structure used in the implementation of colour in
MacTRANS.

To remove these problems, an extended dummy Fortran program, "ExToolbox", was
created by adding the extra "FInclude" files and supplementary declarations to the dummy
Fortran program used to create the "Toolbox.finc" file, and then executing the
"BuildFTNGlobals" command to create an "ExToolbox.finc" file from it. The
"ExToolbox" dummy program is shown below. Note, however, that the
"BuildFTNGlobals" command did not work on "ExToolbox" until the Ermiac. statements
in the "SystemSubs.f" file were removed. The statements removed were identical to those
in the "Globals.f" file and this suggests that they were not needed in the "SystemSubs.f"
file. The "MPW:Interfaces:FIncludes:Read Me" file has further information on the
"Globals.f" file.
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PROGM EX'=OLBOX
!SETC USINGINJDES = FAlSE.
!!I WINDCW.F
S!I MENEIS.F

!!I DIAI.=.F
!!I ENRORS.F
!!I EVE 2TS.F
!!I PACKAGES.F
!!I QUIC DAW.F
!!I TEXrEIT.F
!!I Ft1M'S.F
!!I PRINTING.F

INTG'E*4 NIL

PARAMETERWL. 0)

sr.T .P.E/COLfPAP.PW/
CHARACTER*9 TEXT
REvRD/iGznr./ R

EN STRUCIURE

POInTER/OGRArPOR/ W
EN STKW1URE

A.3 Calling Procedures

The Macintosh Toolbox calls are Pascal functions and procedures, so the same
procedure is adopted as for a Pascal subprogram called from Language System. Fortran.
The most important features of this procedure are:
a) It is necessary to ensure that variables passed in the arguments are of the proper data

type. For example, a Toolbox call may expect to see an standard Pascal integer which
is two bytes long, whereas the standard Fortran integer is four bytes, and should be
converted by using the intrinsic function INT2O.

b) Language Systems Fortran can pass arguments as values (%val o) or by reference
(%Ref (). When the "l!MP Inines.f" compiler switch is used, Language Systems
Fortran defaults to sending arguments to Pascal subprograms as values. In this case,
%val() is optional and most arguments can be passed as they would be in the call to a
Fortran subroutine, but %Ref o must be used when an argument is VARed. Also,
when an argument is a pointer to a variable, %ioc o can be used to give the memory
location of the variable.
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APPENDIX B

TRANS Commands

Table B.1 gives a summary of the TRANS commands. Care should be taken when
using lower case responses to TRANS prompts, as pans of TRANS may not have been
modified to accept them.

TABLE BI
Summary or TRANS Commands

Command Description

BARs Specifies bars on DI-3000 plot curves

EXIt Exits program

GOE Processes the input file to obtain output for the comman,.
PRColumn, PRPlot, PLStrip and PLOverlay

LABel Enables modification and addition to labelling information

LISt Enables a list of blocks to be made or modified

PLOverlay Specifies "overlay" plotting

PLStrip Specifies "strip" plotting

PRColumn Specifies tabular output in the form of printed columns

PRKonstant Specifies printout of all constant blocks

PRPIot Specifies graphical output on a line printer or monitor

REPeat Repeats all previous commands for another input data file

RUN Equivalent to the commands (in order) PRColumn, PRPIot.
PLStrip and GOE; if any form ot output is not required, a carriage
return is typed in place ut 'lock numbers

SCAle Enables the user to specify scale limits for the graphical output

SPAce Enables the space at the left side of a plot to be removed

TIMe Redefines time (independent variable) parameters

XBLock Enables the user to specify any output block to be used as the
independent variable
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